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All text copyright Kevin Davis, 2019. 

Disclaimer:  Any screen captures are included for illustration purposes, may be cropped, and may not 
accurately represent the latest eCopyright web interface. As I aim to help you navigate the eCopyright 
website, the site itself is entirely controlled by the U.S. Copyright Office. 
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If you create a photograph, US law says you automatically own the rights to that image (usage, copy, 
distribution, etc). However, these rights do not have firm power in a court of law unless your images 
have been formally registered with the Copyright office. Unless you have registered, a court of law is not 
even required to hear your case. As lawyer Ed Greenberg (The Copyright Zone) says, copyright is the key 
to the courtroom. 

Should you register your photographs with the US Copyright office? That choice is up to you. If your 
answer is ‘yes,’ then keep reading.  

Photographers can register multiple photographs at the same time. Beginning in 2018, the limit has 
been a maximum of 750 images submitted in a single claim. 

Be careful not to confuse these categories : “Group of Unpublished Works”, “Group of Photographs” 
(unpublished) and “Group of Photographs” (published).  Note that published and unpublished 
photographs cannot be registered together in a single submission. (To register published images, you 
must document where and when the images were published.) We will be looking primarily at Group of 
Photographs (unpublished). 

The good news is that the submission process can be done entirely on-line (through an internet 
connection) and without hiring any service to do it for you. The bad news is that the process can seem 
cryptic or cumbersome until you have completed it a couple times. 

The copyright office will accept images via internet upload or on disc (e.g. CD-ROM) sent via snail-mail; 
however, the online application is basically the same. Herein we will be using internet upload. 

After preparing your images, the process of registration has these basic steps: 

1. Compile a list of files in accord with the Copyright office guidelines  
2. Login to eCopyright web page 
3. Fill out the on-line application 
4. Submit payment 
5. Upload your image files and the file list 
6. A paper copy of your registration will be sent to you via postal/paper mail 

 

Circular #42 - an introduction to copyright of photographs: 
https://www.copyright.gov/circs/circ42.pdf 

A more detailed walk-through is available here: 
https://www.copyright.gov/eco/help/group/grpph.html 

While that information is essential, the process can still be confusing to first-time users.  So, from one 
photographer to another, I offer this guide to help to you. 

Preparing your images for submission 

Preparing many images for upload is relatively simple using any photo-organizer software; I use Adobe 
Lightroom. Select the images and export them to a temporary folder as reduced-size jpeg files with 
reduced resolution.  

https://www.copyright.gov/circs/circ42.pdf
https://www.copyright.gov/eco/help/group/grpph.html
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Copyright does not require full-resolution images. For a normal rectangular aspect ratio (not panorama) 
an acceptable resolution is 700 or 800 pixels along the longer edge. 

While other file types are supported (www.copyright.gov/eco/help-file-types.html), Jpeg is the perfect 
balance of quality and compressed size.  

I must warn you of a trap, which I myself have fallen into multiple times.  In the course of preparing 
images, I commonly discover work that I had previously neglected.  For example, a group of images that 
I forgot to edit, images that yet need to be panorama-stitched, and images that yet need to be post-
processed for HDR.  All this means that submitting images may need to be postponed until prerequisite 
tasks are completed. Although this feels like a nuisance, it is necessary work and the intent to submit for 
copyright forces me to do what I should have done long ago. 

File naming 
Before submitting images for copyright, you need to ensure that the filenames are all unique. Review 
the images that you intend to copyright, paying attention to the image filenames.  

Hopefully renaming your images is already part of your post-processing. Many cameras create image file 
names using a simple incrementing number. Upon formatting the memory card, the camera may restart 
the numbering at the beginning. This readily suggests that you may have duplicate filenames if you do 
not explicitly rename them. 

For example, if a file from your camera is named IMG-1002407.jpg., you should at least change the 
prefix; e.g. Springfield-1002407.jpg.  Batch rename of many images is easy to do using any photo 
organizer software. 

File names may contain punctuation and spaces. (Prior to March 2019, filename guidelines disallowed 
punctuation). 

Export re-sized JPEG files 
As today’s cameras commonly capture 20 to 50 megapixels, the image files are not small. A full-
resolution image is not required for copyright. You can and should reduce the resolution before 
submitting for copyright; this can be quite simple depending upon your image-management software. 

Export: Lightroom  

File -> Export  

Folder – the location where you want the images for registration to go;  

Template – filename; 

Format: JPEG; Quality: 70; Color Space: AdobeRGB (1998); 

Resize to fit:  generally, I choose: long edge = 700 pixels; but this is not a good choice for wide 
panoramas.  For panorama, I choose: short edge = 500. 
 

Export: Adobe Bridge & Photoshop 

Create a Photoshop action called “Constrain 700p (for copyright)” 

http://www.copyright.gov/eco/help-file-types.html
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• Image -> Flatten Image 
• Image -> Convert Mode -> 8 Bits/Channel RGB 
• File -> Automate -> Fit Image -> 700 x 700 pixels 
• Save as JPEG 
• Close 

There is yet one problem.  If you attempt to batch process DNG files, they will open in Adobe Camera 
Raw rather than directly in Photoshop. Each image requires that you click “Open” button.  That defeats 
the concept of batch processing.  

To work around the problem, use Photoshop -> Image Processor (instead of Photoshop -> Batch). This 
requires a small change to the Action.   Because the Image Processor includes saving & closing each file, 
change the action to disable the last two steps (Save & Close).  This is a simple matter of removing the 
checkmark in the box to the left of those two steps. 

 

List of files 
Since early 2018, your deposit of images must be accompanied by a list of all the images.  Download a 
preformatted template from the eCO website. To complete this form, you will eventually require a piece 
of information that you do not yet have – the case number assigned to your application.  You should 
prepare your file list in advance; however before uploading the list, remember to modify the list by 
applying the case number. 

The list includes title and filename for each image. Title is arbitrary. For most of us, the title is the same 
as the file name. My practice is to set the title equal to the filename but without the “.jpg” extension. 

Note: If you are registering a group of published photographs, the list also must include the month and 
year that each photograph was published. 

 

The number of images in your list must not exceed maximum number of images (750) allowed in a one 
application/deposit. 

 

If using a Windows computer, here’s one way to list all the filenames in a folder. 

• Launch a command shell (a.k.a. command-line utility); the application name is “cmd” 
• Change your current folder location to the location of your images 

    E.g.:  cd  \Users\Jane\Pictures\Atlanta2019 
• List the files in the current directory using “brief” format and redirect that into a file 

    dir /b > filelist.txt 
• Edit the filelist.txt and remove the one name “filelist.txt” 
• Select all rows in the file (ctrl + ‘A’) and then copy (ctrl + ‘C’) 

You can then paste (ctrl + ‘P’) that list into your eCopyright form/template 
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Create Zip file(s) 
If you are registering hundreds of images, you really don’t want to waste time providing those individual 
files to the eCO website. Instead package them into one or more packages. The eCO website supports a 
small number of compressed archive formats; Zip is the most widely recognized format and is easy to 
use on most computers. 

To create zip files on MacOS, you can use the Archive Utility. Windows does not include such a utility, 
but many applications are freely available. I use an application called 7-zip.  

Example: With 7-zip installed, let’s say my folder full of photo files for copyright is named 
“massachusetts”. Select all files with Ctrl+A (control key and the ‘A’ key). Right click, choose 7-Zip, and 
choose: add to massachusetts.zip.  (The default name is based upon the folder name.) 
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Submitting Electronic copyright - eCO 

Before you begin, note that the eCO website may include “pop up” dialog boxes, which means that you 
need to configure your web browser to allow pop-ups for eco.copyright.gov. 

Second, pay attention to notices on the login page.  A typical notice states that the site is not available 
during a specific time once each week, for routine maintenance purposes. 

To submit a collection of images, there are three parts.  (1) Enter information about yourself (name, 
address, etc) and information about what you are submitting (you are submitting photographs).  (2) 
Provide payment; I always use a credit/debit card but there are other options.  (3) Upload your files. 

Open a new copyright case with eCO 
Simply click “Group of photographs”.  
Notice that subsequent pages of the form show your assigned case number at the top. 

 

 
The next page (entitled “Type of Group”) asks if the images have been published or not. Unpublished 
necessarily implies that you have not published in print nor on-line; not Facebook, not Instagram, etc. 
For the purposes of the help guide you are reading, we will assume all images are unpublished. 
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Notice that the top of the page shows a case number that has been assigned to your copyright 
application. Using this number, you must include it in your document that lists titles and filenames.  
Furthermore, you must rename that document to include the case number.  For example, if you have a 
spreadsheet called “Titles2019.xlsx”, rename it to “Titles2019 case number “ + case number + “.xlsx”. 

 

Titles 

Notice the top left of your screen informs you that you are entering data into the application form 
(“form” is highlighted) and the specific page of the form: Titles. 
 
Click the “New” button and provide a title for your collection of photographs. 
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Notice the text on this page. Upon providing the title, you are advised to provide additional information; 
the process can be awkward. (This recommendation is also stated at the top of the template where you 
listed all your file names.) The recommendation is to copy all of your titles and paste them into a field on 
the web form which is not capable of accepting 750 entries. If you attempt to paste too many title 
names all at once, the form will warn you that the list has been automatically truncated. You must 
repeat the process several times until all the names have been entered. Each time you do this, you must 
somehow identify exactly how many names have been entered (before truncation). Alternatively, you 
could explicitly enter a fixed number of titles that you know will fit, perhaps 100 names; in that case, the 
“number of photos” field would always be 100. 

 

In the example shown here, notice two details. The “Type” column shows that the first row is different 
than all those that follow. And the sum of the title counts does add up to the total number on the first 
row. 

As the detailed information here is entirely redundant, why is it recommended? I don’t know. 
As the method of entry is extremely awkward, can you skip this step entirely? Yes. 
What is the consequence of skipping this step? I don’t know. 

I surely hope that eCO should improve this in the near future. Either the field on the form must be able 
to accept all file names at once, or the information should be automatically extracted from the file list 
that you will subsequently upload. 

Author, Claimants, Rights, Correspondent 

If your photographs are solely your own work and not work for hire, these pages are quite straight-
forward – you are merely entering your own contact information.  Because each of these are commonly 
identical, each page provides a “Add Me” button to make it easy. 
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Mail Certificate 
Provide your address to where the copyright office will mail a printed certificate. 

Special Handling, Certification 
Special handling:  if you don’t need special handling, simply click on “Continue”. 

Certification 
There are two important elements on this screen. 

• Confirm “I am the author, copyright claimant, or owner of exclusive rights” etc. 
• The name of the file containing your list of image filenames. 

When you have completed this page, the next page shows a summary of your application. 
Verify the information. Then click “Add to cart” (add to shopping cart for checkout). 

Fee payment 
When you click “checkout”, you are temporarily redirected away from the eCO website to a payment 
website. When you complete the transaction, you will be automatically sent back to eCO so you can 
submit your images. 

You can pay either by providing a bank account (referred to as ACH Payment) or a credit card.  
The exact details changed during 2019; the change was for the better and payment seems self-
explanatory. 

Upon completion of your payment, you should receive an email confirming your payment. In fact, I 
expect two emails, one from Pay.gov and the other from the Copyright Office. 

Submit Your Work 
Upload your files via the eCO website. Although you can copy your images to an optical disk and send it 
via postal snail-mail to the Copyright office, I see no value in doing that. Here, I am only considering 
internet upload, also known as “submit your work” or “upload your deposit”.  

Notice that the eCO page includes (1) Upload your work(s) and (2) Send your work(s) by Mail. Choose 
one and not both. 

You can collect all your images into a single zip file, along with your title list document. Personally, I 
prefer to create multiple zip files. When a deposit consists of multiple files (e.g. several different zip files, 
each containing the photos from different shoots), the eCO web interface allows you to specify multiple 
names and then click a button to upload all of them. After uploading files, you can still add more and 
upload those.  Your submission is not finalized until to click a button to finalize it. 
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Don’t forget to include the document containing your list of titles/files. Personally, I don’t bother to zip 
that file; I simply submit the spreadsheet document. (The eCO website provides a list of acceptable file 
formats.)  

When you click the “Start Upload” button, you should see the progress bars filling up with green color. 
When all the files have completed, you should receive an email confirming the uploaded files (and the 
size of each file).  

You may encounter an upload error; it is not uncommon and is simple to resolve. To retry those files, 
click the “Select Files” button to add them again, then “Start Upload” again. For each time you initiate 
file upload by clicking on “Start Upload” you will likely receive a separate email confirming the upload.  
(E.g. if you upload some files, then upload some more files, you should receive two confirmation emails.) 

On at least one occasion, I have seen a problem with the website such that upload ceased to function. 
Upon logout from the website, close the web browser, and restart, I did not have any further trouble.  
Upon logging in once again, you will see a link to your open submission; just click on that and resume 
uploading. 

Having selected files and uploaded them, your application remains open/incomplete. You can select 
additional files and upload those separately.  You can even log out and return later. Your application is 
finished only when you click the button labeled “Click here to complete your submission”.  (The upload 
page usually states that you have a limited number of days that your application can remain open. ) 

The final page should show “Upload complete. No further action required.”  And subsequently, you 
should receive an email entitled something like “Acknowledgement of Uploaded Deposit”. 

Logout from the eCO website. You are done.   



12  

 

After completing the submission, the case is in a “completed” state and no more files can be added. 
However, I did once forget to upload my spreadsheet containing the title and filename list. As I realized 
my error within minutes after completing the submission, I immediately contacted the copyright office 
electronically, specified the case number, and asked how I might upload the list.  Within a couple days, I 
received a reply and they changed the case from completed back to incomplete, thus allowing me to 
upload the additional file. Then I again clicked “Click here to complete your submission” and the case 
was once again in the completed state. 

At this point, your job is done and the Copyright Office will process the claim in due time.  In due course, 
you will receive a paper certificate of your copyright registration. 

 

Wrap It Up 
For your own records, save your .zip files and title list. Then you can delete the temporary folders that 
you used for uncompressed low-resolution images before creating zip files. 

Further, I recommend maintaining a document that lists every copyright submission and the date that 
each was submitted. 

Certificate of Registration 
In 2019, certificate of registration is sent via paper. While many businesses (financial, medical, etc) 
encourage you adopt paperless delivery, U.S. copyright did not yet offer paperless delivery. 

If you fulfilled the optional step of providing individual image title names, then the certificate will list all 
of those titles. From personal experience, a list of 734 image titles required three printed pages. If you 
only provided a document containing titles, then certificate states the number of images without the 
detailed list; the certificate is likely a one-page document. 
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